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Gijs Koedam Voorzitter focusgroep RoPlan

Noeste werkpaarden

Nieuwe ontwikkelingen en nieuwe mogelijkheden 
buitelen over elkaar heen. Alles moet ‘social’, 3D of 
anders wel ‘smart’ zijn. Prachtige ontwikkelingen, die 
steeds beter ondersteund worden in steeds weer 
nieuwe versies van de software die we gebruiken. 

Maar natuurlijk zijn er ook gewoon werkprocessen waar 
vernieuwingen niet alle dagen toegepast worden of 
kunnen worden, zeg maar het ouderwetse dagelijkse 
productiewerk. Bij bestemmingsplannen bijvoorbeeld. 
Daar heeft zich een stille revolutie voltrokken, die 
niet gebaseerd is op spectaculaire nieuwe technische 
ontwikkelingen of mogelijkheden. Maar niettemin 
een revolutie, in het besef dat ook juridische 
processen digitaal kunnen en dat dit grote voordelen 
heeft. Inmiddels zijn digitale bestemmingsplannen 
wettelijk verplicht en worden dus aan de lopende 
band gemaakt. Gewoon productiewerk. Met RoPlan 
bijvoorbeeld. Een noest werkpaard waarmee al 
sinds jaar en dag op basis van MicroStation (en 
later Bentley Map) digitale ruimtelijke plannen 
worden gemaakt. Eén van de eerste applicaties op 
MicroStation voor dit doel en al bijna tien jaar oud. 

Niet meer nieuw dus, maar wel steeds mee 
doorontwikkeld met de veranderende ideeën rondom 
digitalisering van bestemmingsplannen. En eigenlijk 
bepaald ook niet saai; IMRO2003, IMRO2006, 
IMRO2008, de versies van het Informatie Model 
Ruimtelijke Ordening volgen elkaar net zo snel op 
als de versies van MicroStation. En we zijn net goed 
en wel gewend verplicht te werken met IMRO2008 
of IMRO2012 komt er alweer aan. Dat betekent ook 
weer een nieuwe versie van ons trouwe werkpaard. 
Veel gemeenten met MicroStation gebruiken ook 
RoPlan en de resultaten daarvan zijn inmiddels te 
bewonderen op www.ruimtelijkeplannen.nl, de 
landelijke voorziening voor digitale plannen.

En die nieuwe ontwikkelingen komen er 
uiteindelijk ook wel. IMRO2012 is nog 2D, 
maar het zou me niet verbazen als de versie 
daarna ook 3D-bestemmingsplannen gaat 
ondersteunen. Voorlopig voldoende redenen 
om een focusgroep RoPlan te laten bestaan!

gijs.koedam@arnhem.nl
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Omslagillustratie

Door: Christiaan Post, Grontmij
Visualisatie project Natuurbrug Zandvoort
Gebruikte software:  
MicroStation V8i SS3 en PowerCivil

322
www.crotec.nl

Passie voor Geo



4

Kort nieuws

Nieuw: CrOteCliNk, OpvOlger vaN OmegaliNk 
Met de introductie van CrotecLink leveren Crotec, Bentley en Oranje-
woud in één klap drie voordelen op voor alle MicroStation-gebruikers 
van de applicatie GBI (Beheer Openbare Ruimte) van Oranjewoud.
1.  Door het vervangen van OMEGALink door CrotecLink komt alle kop-

pelfunctionaliteit met GBI beschikbaar in de nieuwste MicroStation V8i 
SS2-omgeving. Hiermee vervalt de noodzaak voor het gebruiken van 
twee verschillende MicroStation-versies binnen één organisatie.

2.  Deze nieuwe CrotecLink-koppeling is in samenwerking met Bentley 
tot stand gebracht. Onder het SELECT Portfolio Balancing-mecha-
nisme maakt Bentley het voor alle huidige OMEGALink-gebruikers 
mogelijk om zonder kosten de OMEGALink-licenties om te ruilen 
voor de benodigde Bentley Map-licenties. CrotecLink dient wel 
apart aangeschaft te worden en wordt nog in 2011 leverbaar.

3.  Door het beschikbaar maken van Bentley Map op de GBI-beheer-
werkplekken komt GIS-functionaliteit eenvoudig binnen handbe-
reik. Thematische kaartgeneratie, gebruiksvriendelijke plot- en 
printfunctionaliteit, maar vooral omgevings- en risico-analyses 
zoals ‘bomen nabij riool’ of ‘bomen nabij verlichting’, behoren 
daarmee standaard tot de functionaliteiten. www.crotec.nl

terugblik NedgraphiCsdag 2011
De achttiende editie van de NedGraphicsdag trok ruim 400 bezoe-
kers, 25 business partners en een groot aantal sprekers uit de Geo-
ICT, die de plenaire en parallelle sessies voor hun rekening namen. 
Ir. Noud Hooyman, hoofd programmabeleid Geo-Informatie bij het 
Ministerie van I&M, vertelde wat de speerpunten van het ministerie 
zijn op het gebied van geo-informatie in Nederland. Albert Tieken 
(projectmanager BGT pilots) informeerde iedereen over de stand 
van zaken per 20 september 2011 en Marcel Reuvers van Geonovum 
vertelde over IMGeo 2.0. Uiteraard ontbrak ook de visie van Wil van 
de Berg op de BGT niet, evenals een demonstratie van het product 
NedBGT dat NedGraphics ontwikkelt. Ook werd er in het parallelle 
programma aandacht besteed aan thema’s als BIM en NLCS en wer-
den de nieuwste ontwikkelingen van de producten waar de aanwe-
zigen dagelijks mee werken toegelicht en gedemonstreerd. Mede 
door de vele positieve reacties van zowel klanten als partners kijkt 
NedGraphics terug op een zeer geslaagde NedGraphicsdag 2011. 
Volgend jaar vindt de NedGraphicsdag op 18 september 2012 plaats.

CONNeCtOr gwp - glObespOtter
Met Bentley Geo Web Publisher beschikt u over optimale publica-
tiemogelijkheden, waarmee u verschillende gegevensbronnen kunt 
integreren, websites kunt maken en beheren en optimaal gebruik 
kunt maken van uw GEO (ruimtelijke) informatie. Binnen de GWP 
omgeving is een directe interactieve koppeling met GlobeSpot-
ter gecreeërd. GlobeSpotter is een uitgebreide gebruikerstoepas-
sing voor Cyclorama’s en LuchtfotoNL. De applicatie voorziet in 
een ontwikkelinterface waarmee GlobeSpotter in GIS/CAD ap-
plicaties geïntegreerd kan worden.Eind december is de connec-
tor tool beschikbaar voor MicroStation. www.it-pro people.nl 

verhuiziNg kaNtOOr  
beNtley NederlaNd
Het Nederlandse Bentley-kantoor 
is verhuisd van Vianen naar 
Culemborg. Het nieuwe adres is 
Godfried Bomansstraat 2,  
4103 WR Culemborg.  
Telefoon: 023 - 556 0600.

Nieuw liCeNtiemOdel 
beNtley
Bentley introduceert Portfolio Ba-
lancing. Hiermee kunnen klanten 
jaarlijks hun licenties aanpassen, 
afhankelijk van de behoefte van 
dat moment. Software die minder 
gebruikt wordt kan geruild worden 
voor andere Bentley-software 
met dezelfde waarde. Een en-
kele applicatie van Bentley kopen 
(met SELECT) geeft dus in feite 
toegang tot het gehele Bentley-
portfolio.

aCtie pOwerCivil fOr beNe-
lux + OrgaNize
De combinatie PowerCivil for 
Benelux + Organize for Benelux, 
het programma voor de NLCS-
standaard van Para_Graph, zijn 
nu als aanbieding te verkrijgen bij 
IT-PRO People.  
 
ruimtesChepper
Ruimteschepper is een nieuw pro-
ductonafhankelijk kennisinstituut 
dat zelfstandige geo-experts (ZZP-
ers) en opdrachtgevers in de geo-
ict met elkaar verbindt. Het is een 
initiatief van geo-ondernemers Jan 
Roodzand, Jochem Mollema en 
Douwe Blanksma. 
www.ruimteschepper.nl
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NIEUW

ONTDEK WAT JOU 
SMARTPHONE JE NOG 
MEER TE BIEDEN HEEFT

» de nieuwste apps
» de best geteste smartphones

» de handigste tips

Kijk voor actuele abonnementsaanbiedingen op:

www.android-magazine.nl
»twitter

@AndroidMag_NL
Volg ons op twitter en tweet je 

vragen en opmerkingen

AN.indd   2 20-09-11   11:21

Agenda

12-13 oktober 2011 dag van de Openbare ruimte
www.dagvandeopenbareruimte.nl

Expo Houten

5 november 2011 be inspired event bentley
www.bentley.nl

Hotel Okura, Amsterdam

8 november 2011 bijeenkomst basisregistratie Ondergrond
www.tno.nl/BROinformatiebijeenkomsten 

TNO, Utrecht

30 november 2011 geo-info xchange/giN Congres
www.geoinfoxchange.nl

Jaarbeurs Utrecht

7 december 2011 Openbare ruimte Congres 2011
www.crow.nl

Gemeente Ede

16 februari 2012 Crotecdag
www.crotec.nl

Brabanthallen, Den Bosch
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3D ontwerpen met Bentley PowerCivil en Bentley InRoads

Veel projecten hebben een grote ruimtelijke impact. De huidige markt 
vraagt om steeds meer inzicht in de ruimtelijke consequenties. Een ont-
werptekening in het platte vlak is vaak niet meer voldoende en het ontwer-
pen in 3D is een prima hulpmiddel om deze inzichten juist wel te krijgen. 
Naast de voordelen die het heeft binnen het gehele ontwerpproces, omdat 
conflicten binnen het ontwerp veel eerder aan het licht komen, heeft het 
3D-ontwerp nog meer positiefs. Zo was het voor deze opdrachtgever heel 
belangrijk om beelden te hebben, die zij konden gebruiken om te com-
municeren over het project, zowel intern als extern (bewonersavonden). En 
zoals wij natuurlijk allemaal weten zegt één plaatje meer dan duizend…

Inmeting

Wie gaat bouwen moet altijd een goed beeld hebben van de uitgangssituatie. 
Actuele kennis van de projectlocatie is onmisbaar. Hoe ziet de omgeving eruit? 
Welke bovengrondse objecten moeten behouden blijven? Lopen er leidingen 
door de grond? Hoe hoog ligt het bouwterrein? Grontmij maakt gebruik van 
geavanceerde instrumenten en technieken om de boven- en ondergrond in kaart 
te brengen. Voor dit project is onze afdeling Geogroep naar buiten gestuurd 
om alles digitaal in te laten meten: DTM (Digitaal Terrein Model), om zo een 

Over de Zandvoortselaan in Zandvoort wordt 

binnenkort een uniek natuurproject gerealiseerd: 

natuurbrug Zandpoort. Een noodzakelijke schakel 

om de prachtige Noord-Hollandse duinen met 

elkaar te verbinden. Tevens moet er over deze 

brug een fiets-, voet- en ruiterpad gerealiseerd 

worden, die de oversteek van het wild niet mogen 

verstoren.Tijdens een presentatie op een bijeen-

komst van de 3D Focusgroep, die dit voorjaar bij 

de gemeente Utrecht plaatsvond, heb ik het één 

en ander laten zien over dit project. Twee soft-

wareoplossingen van Bentley zijn hierbij gebruikt 

die niet erg bekend zijn, maar wel van cruciaal 

belang bij het ontwerpen van civieltechnische 

projecten; Bentley PowerCivil en Bentley InRoads.
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3D ontwerpen met Bentley PowerCivil en Bentley InRoads
Tekst: Christiaan Post, Grontmij
Illustraties: Grontmij

betrouwbare basis te hebben waarop wij ons ontwerp kunnen realiseren.

Schetsontwerp

Om een idee te krijgen van de ruimte, die het ontwerp beslaat, is 
er een schetsontwerp gemaakt waarbij een aantal uitgangspun-
ten al helder waren, zoals de hoogte van het nieuwe kunstwerk. 
Dit in verband met de vereiste doorrijhoogte van de Zandvoort-
selaan. Met een rekenmachine en het handboek Ontwerpwijzer 
Fietsverkeer van de CROW was het natuurlijk een kleine moeite 
om de benodigde lengtes van het fiets/voetpad te berekenen. Dit 
resulteerde in het schetsontwerp zoals hiernaast afgebeeld.

Ontwerp kunstwerk

Op de afdeling Kunstwerken binnen Grontmij wordt gewerkt met Revit 
Structure, waarin het ontwerp van de brug in 3D is gemodelleerd. Dit 
model kunnen wij middels de i-model plug-in voor Revit (dit is een 
container file voor open infrastructurele informatie-uitwisseling) expor-
teren naar een bestandsformaat (*.i.dgn) wat de Bentley-producten kan 
inlezen door deze als reference file in te laden. Op basis van een aantal 
uitgangspunten, zoals de maximale helling van de taluds, heb ik met 
behulp van Bentley PowerCivil het toekomstige grondmodel ontworpen.

Ontwerp grondwerk

Om het schetsontwerp van het fiets/voetpad verder digitaal uit te 
werken hebben wij een nieuw grondwerkmodel nodig, dat aansluit bij 
het te bouwen kunstwerk. Hiervoor is Bentley PowerCivil gebruikt, 
omdat dit een goede tool is om het nieuwe grondwerkmodel mee 
vorm te geven. Dit heb ik gedaan aan de hand van de hoogtelijnen, 
zoals die in het ontwerp door één van onze landschapsarchitecten 
zijn aangegeven. Hierdoor is ook direct inzichtelijk wat de hoe-
veelheden van het te ontgraven en aan te vullen grondwerk zijn.

Ontwerp fiets/voetpaden

Nu het grondwerkmodel gereed is, is de fase aangebroken om het 
fiets/voetpad verder uit te gaan werken met Bentley InRoads. Het 
principe van InRoads is best wel eenvoudig. Je hebt vier ingrediën-
ten nodig om het ontwerp te kunnen maken: de bestaande situatie 
(DTM), de as van het fietspad, het lengteprofiel en het bijbehorende 
dwarsprofiel. Deze worden met elkaar gekoppeld, waarna het ontwerp 
van het fietspad een feit is. Natuurlijk zijn er daarna nog zaken die 
verder uitgediept moeten worden, zoals het genereren van de gebrui-
kelijke 2D-tekeningen en de dwarsprofielen, maar de basis hiervoor 
blijft het 3D-model. Dit is ook de kracht van InRoads, doordat 

Schetsontwerp natuurbrug Zandpoort

Overzicht grondwerk
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“Ontwerpen in 3D heeft zeer veel voordelen 
en de huidige markt vraagt steeds meer 
inzicht in ruimtelijke consequenties.”

je eenvoudig wijzigingen kunt aanbrengen. Bijvoorbeeld als er toch 
een ander dwarsprofiel moet komen met een andere opbouw. Deze 
kun je snel maken en zo dus heel flexibel met je ontwerp omgaan. 
Ook hier hebben we gelijk weer inzicht in alle hoeveelheden, inclu-
sief de opbouw van de constructie, zoals zand, granulaat en klinkers.

2D-tekeningen

Tot slot wil ik nog iets vertellen over de 2D-tekeningen, die gebruikt worden 
bij de uitvoering van het project. Nu we alles in een intelligent 3D-model 
hebben staan, is het een kleine moeite hiervan 2D-tekeningen te genere-
ren. Hierbij kan je denken aan tekeningen met de nieuwe hoogtelijnen en de 
contouren van het ontwerp van het fiets/voetpad. Wat ook heel belangrijk 
is om inzicht te krijgen, zijn natuurlijk de dwarsprofielen, die eenvoudig te 
genereren zijn op bijvoorbeeld een regelmatige afstand van tien meter. Hier-
mee krijg je er nog meer gevoel bij hoe het verloop van het grondwerk er 
uitziet. Dit zijn dus complete profielen met hoogtes en dergelijke waar je niet 
meer naar hoeft om te kijken, want zodra het model wordt aangepast heb 
je met twee muisklikken de nieuwe profielen weer op je tekening staan.

Ingewikkeld?

Misschien lijkt het een ingewikkeld verhaal, maar niets is minder waar. Als je een 
beetje vertrouwd bent geraakt met het denken in 3D, dan zul je zien dat deze 
tools je prima kunnen helpen bij het realiseren van civieltechnische projecten. 

Links: dwarsprofiel fietspad

Onder: lengteprofiel fietspad
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Boekennieuws

Basishandleiding 2D voor MicroStation V8i 

(SELECTseries 2)

326 pagina’s in kleur met veel illustraties, 
screenshots en oefeningen. Geschikt voor 
de beginnende gebruiker en onmisbaar 
voor iedere gebruiker die met Micro-
Station V8i werkt of gaat werken. Met 
praktijkgerichte tips en trucs om een 
stevige basis te krijgen en de vele mogelijk-
heden van MicroStation te verkennen.
Aan de hand van oefeningen en voorbeel-
den leert u de kracht van MicroStation V8i 
gebruiken. Met zeer veel screenshots en 
illustraties van de nieuwste MicroStation 
interface in een Windows 7 omgeving wordt 
ingegaan op zowel installatie, de nieuwe 
gebruikersinterface, Snaps, AccuDraw, het 
werken met lagen, selectiemogelijkheden, 
groepen, motieven, cellen, teksten, meten, 
manipulatie, attributen, bematingen, ras-
ters, referenties, modellen als printen. De 
auteur is Ronny Verbruggen van 4D-select. 
Bestellen kan voor € 90,- excl. BTW en 
verzendkosten. www.cad2reality.nl/index.
php/microstation/basishandleiding-2d.htm

BGT en IMGeo boek

Naar aanleiding van het seminar “BGT en 
IMGeo 2.0” hebben Crotec, Oranjewoud en 
Unafact een speciaal boek over dit onder-
werp uitgebracht. Alle presentaties van het 
seminar, maar ook achtergrondinformatie 
over BGT en IMGeo zijn gebundeld in dit 
boekwerk. Het boek werd aanvankelijk alleen 
gedrukt voor de bezoekers van het seminar, 
maar gezien de overweldigende belangstel-
ling hebben de bedrijven besloten een tweede 
druk uit te brengen. Inmiddels is IMGeo 2.0 
definitief vastgesteld en in de nu te bestellen 
versie zijn ook deze gegevens verwerkt. Het 
boek is uitgebracht in kleur, om de details 
goed over te laten komen en de presentaties te 
laten herleven. De gepersonaliseerde exempla-
ren van het BGT en IMGeo boek zijn voor 
€49,50 na te bestellen. Crotec, Oranjewoud 
en Unafact hopen op deze manier een bijdra-
ge te leveren aan de eerste stappen naar het 
definiëren, samenstellen, opbouwen, uitwis-
selen en aanleveren van de BGT en IMGeo 
2.0, hierbij ook al rekening houdend met 3D 
IMGeo. Informatie: www.crotec.nl/bgtboek 

Voor gebruikers van Bentley-software zijn er 

verschillende boeken te raadplegen. Bent-

ley Institute Press verkoopt diverse boeken 

in het Engels en een aantal actieve Bentley 

partners in de Benelux heeft Nederlandstalige 

boeken. Voorbeelden zijn het cursusboek 

van The People Group en de basishandlei-

ding 2D van 4D SELECT. En onlangs hebben 

Crotec, Oranjewoud en Unafact een BGT 

en IMGeo boek uitgebracht. We laten u 

kennis maken met een tweetal boeken.
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Open Geospatial Consortium

Als u dit leest, ben ik alweer terug van mijn trip naar 

de OGC-bijeenkomst (Open Geospatial Consortium) 

in Boulder, Colorado. Maar nu zit ik dit artikel te typen 

in het vliegtuig op weg naar deze vijfdaagse bijeen-

komst. Als ik zo klaar ben, kan ik het direct verzenden 

naar de redactie via de on-board WiFi in dit vliegtuig. 

Mijn WiFi-connectie thuis, op kantoor, op het vlieg-

veld, bij de McDonalds en in de lucht werken bijna 

automatisch. Ik hoef er niet bij na te denken.Hooguit 

beslissen of ik wil betalen voor de service op dat 

moment of wil wachten tot ik een hotspot vind, die 

vrije toegang biedt. Gelukkig is het gebruik van WiFi 

gestandaardiseerd en uniform, waar ik ook ben. 

Ik ga dus naar de bijeenkomst van het Open Geospatial 
Consortium in Boulder. Naast het vier dagen bijwonen en mee 
discussiëren in de meer dan vijftien standaardiseringcomités 
van het OGC, is er ook een 3D Summit georganiseerd door de 
3D-domeinwerkgroep. Daarover straks meer. Mee discussiëren 
in meer dan vijftien relevante OGC-werkgroepen is wat mijn 
collega’s Paul Scarponcini, Alain Lapierre, Nicolas Loubier, 
Francois Valois, Benoit Fredericque, Francis Rabuck, Jeff Nolan, 
Mike McSween en vele anderen regelmatig doen. De OGC-
werkgroepen houden vaak online bijeenkomsten en mijn col-
lega’s helpen zo actief mee in het definiëren van standaarden als 
WMS, WFS, GML, CityGML, etc. Tijdens de kwartaalbijeen-
komsten wordt de voortgang besproken en wordt er gestemd 
over de implementatie van nieuwe of vernieuwde standaarden. 
Bentley is als ‘Principal Member’ één van de vijftien organisa-
ties, die in de ‘Architectural Board’ en het technisch comité nog 
een laatste goedkeuringsstem heeft tijdens deze kwartaalbijeen-
komsten. Alain, Paul of ikzelf vervullen bij toerbeurt deze rol. 

NEWS FROM EXTON, PA
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Open Geospatial Consortium
Tekst:  Ton de Vries, Solutions Executive Government Bentley Systems Inc.

OGC is een belangrijke organisatie. Stefano Morisi, onze Vice 
President voor Geospatial Europa, is vrijwilliger in de OGC board 
of directors en ook aanwezig in Boulder. Meteen een goede ge-
legenheid om weer eens met hem bij te praten vanavond. Eens 
kijken of we een gezellig restaurant kunnen vinden waar ze na 
afloop van het diner ook een fatsoenlijke espresso serveren.

Maar waarom spenderen we zoveel tijd in het helpen definiëren 
van standaarden? Eigenlijk is het antwoord eenvoudig en voor de 
hand liggend, gezien mijn introductie van het gebruik van WiFi: 
Standaardisering van gegevensopslag en uitwisseling helpt ons al-
lemaal verder in het uitwisselen en gebruik van (geografische) ge-
gevens. Wie maakt er nu geen gebruik van bijvoorbeeld WMS of 
WFS in zijn web GIS-omgeving? Of, en dan komen we richting 
de 3D Summit waar ik het eerder over had, hoe zorg ik ervoor 
dat mijn 3D CityModel uitwisselbaar is met andere organisaties 
of gebruikt kan worden met verschillende softwarepakketten? 

CityGML

Dat laatste is waar de 3D Summit dieper op ingaat en met name het 
gebruik van CityGML als opslag en uitwisselingsformaat voor 3D-
modellen. Velen zien CityGML alleen als uitwisselingsformaat, maar 
CityGML biedt meer dan alleen standaardisering ten behoeve van 
uitwisseling. CityGML definieert ook verschillende detailniveaus, 
zodat  er in een enkel model op verschillende detailniveaus gewerkt 
kan worden. Bijvoorbeeld: u heeft uw city model up-to-date als block 
model (LOD 1), maar u werkt aan een project in de binnenstad 
en heeft goede BIM-modellen van een aantal panden. CityGML 
biedt u de mogelijkheid om deze meer gedetailleerde informatie op 
te slaan in hetzelfde datamodel. U kunt dus een mix van gedetail-
leerde en minder gedetailleerde informatie in een model opslaan. 

Daarnaast biedt CityGML ook de mogelijkheid geometry, topology en 
semantics van objecten op te slaan. Niet alleen wordt uw model daarmee 
meer intelligent, uw model wordt daarmee ook bruikbaar voor meerdere 
toepassingen. Op het 3D Summit van het OGC wordt bijvoorbeeld uit-
gebreid stil gestaan bij de resultaten van de 3D Pilot, die Jantien Stoter 
van het Kadaster heeft georganiseerd en inmiddels het vervolg van heeft 
opgestart. Ik ga vertellen en laten zien hoe een 3D-model voor verschil-
lende toepassingen, zoals civiele techniek, BIM, constructie en onder-
houd van city infrastructuur gebruikt kan worden. Daarnaast zit ik in 
een panel met onder andere Xavier Lopez van Oracle en Carl Reed van 

OGC, waarin we de toekomst van 3D-toepassingen bediscussiëren met 
het publiek. Natuurlijk ga ik ook vertellen dat Bentley een CityGML 
extensie (datamodel en applicatie extender) beschikbaar heeft voor Bent-
ley Map. Gratis te downloaden voor iedereen, die Bentley Map heeft. 

Word lid van de OGC

Bentley support het OGC en vanaf deze plek wil ik u oproe-
pen ook lid te worden van het OGC. Een gemeente kan al voor 
$200 per jaar deelnemen onder het GovFuture programma. 
En als u nu lid wordt, geeft Bentley u het eerste jaar lidmaat-
schap terug als korting op uw Bentley Map aanschaf*! 

Tot slot van mijn ‘News from Exton, PA’, hoop ik velen van u terug 
te zien tijdens de BE Inspired conferentie, die dit jaar op 9 en 10 
november in het Okura in Amsterdam gehouden wordt. Voor de-
tails over deelname kunt u natuurlijk altijd contact opnemen met 
uw Bentley account manager of op de Bentley website kijken. 

*zie www.Bentley.com/3dcitygis 
voor voorwaarden en details.
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Tips en Trucs: nog handiger selecteren?

In MicroStation zijn er vele manieren om elementen te 
selecteren, wat ook steeds weer handiger en sneller 
gaat. Element Selection en de PowerSelector zijn nu 
samengevoegd met uitgebreide Tool Settings. Naast 
selecteren door elementen aan te wijzen, is het ook 
mogelijk om te selecteren op Level, Color, Element 
Type etc.. Mocht dan nog steeds niet lukken wat de 
bedoeling is, dan kan je altijd nog kiezen voor Select 
By Attributes (menuoptie Edit>Select By Attributes), 
waarbij je altijd wel weer een beetje moet nadenken. 
Wat valt er dan nog meer te wensen voor een door-
gewinterde MicroStation-gebruiker? De gratis tool-
tjes PokeItSelector & PokeItViewer! Ik zal uitleggen 
waarom en hoe het werkt.

pOkeitseleCtOr & pOkeitviewer
Ten eerste moet je naar http://lmnts.lmnarchitects.
com/bim/microstation-shareware-pokeitselector-
pokeitviewer surfen en het tooltje downloaden. Je kan 
ook zoeken op de Communities site van Bentley. In de 
download zitten twee MVBA-bestanden: een DGNLIB 
en een Engelse handleiding. De MVBA-bestanden 
moeten naar een directory gekopieerd worden waar de 
variabele MS_VBASEARCHDIRECTORIES naar verwijst 
(bijvoorbeeld C:\ProgramData\Bentley\MicroStation 
V8i (SELECTseries2)\WorkSpace\Standards\vba) en 
de DGNLIB naar een directory waar de variabele MS_
DGNLIBLIST of MS_GUIDGNLIBLIST naar verwijst.

CONtext meNu
Handig is dat de DGNLIB ervoor zorgt dat het Context 
Menu aangevuld wordt. Het Context Menu zie je als je 
de rechtermuisknop ingedrukt houdt. In dit geval rea-
geert het nieuwe menu alleen als één of meer elemen-
ten geselecteerd zijn. Dit verraadt meteen de werking. 
Je kan elementen selecteren op basis van hun attribu-
ten (zoals Level, Color, Line Style etc.), alleen hoef je 
dit niet te kiezen uit een lijstje, maar wordt dat bepaald 
door het geselecteerde element (of meerdere).

voorbeeld:
Als je alle elementen van een bepaalde kleur wilt se-
lecteren, activeer je het commando Element Selection, 
beweeg je over een element met de gewenste kleur 
en hou je de rechtermuisknop ingedrukt. Kies voor de 
optie Select Elements By...>Color. Klaar!

In het submenu kan 

het gewenste at-

tribuut gekozen wor-

den om te filteren.

Context Menu’s zijn slim. Zo weten zij bijvoorbeeld wat 
voor type element geselecteerd is. Als dit een Cell is 
kan je kiezen voor Select Elements By...>Cell Name.

Als een Cell gese-

lecteerd is wordt 

een ander submenu 

getoond.

tip:
Als je bijvoorbeeld alle Circles en Arcs wilt selecteren 
dan kan je eerst één Circle en één Arc selecteren. Ver-
volgens druk je op de rechtermuisknop en kies je voor 
Select Elements By...>Element Type.

displaysets
Ik ben een liefhebber van het werken met Displaysets. 
Ik gebruik het als een snelle manier om alleen de ele-
menten op het scherm te zien waar ik op dat moment 
iets mee wil doen, zonder last te hebben van elemen-
ten die ‘in de weg zitten’. Vooral in 3D is dit handig, 
want daar zie je snel door de bomen het bos niet meer. 
Je kan dan wel Levels uit gaan zetten, maar vaak wil je 
ook weer terugkeren naar de uitgangssituatie en dan 
moet je precies weten welke Levels aan of uit stonden. 
Voor dit ‘probleem’ is een tweede optie toegevoegd 
aan het Context Menu, namelijk View Elements By...

voorbeeld:
Je wilt alleen maar elementen zien, die op een bepaal-
de Level getekend zijn. Selecteer een element en druk 
op de rechtermuisknop. Kies vervolgens voor de optie 
View Elements By...>Level. Als je de elementen van 
meerdere Levels wilt zien dan kies je van tevoren een 
element op iedere gewenste Level.
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Tips en Trucs: nog handiger selecteren?

View Elements By... maakt automatisch een Display Set aan...

...met dit als resultaat. Let op de informatie in de Statusbar

Maar hoe kom je weer terug in de uitgangssituatie? 
Druk wederom op de rechtermuisknop en kies voor de 
optie Displayset Clear.

statusbar
In de Statusbar (aan de onderkant van het MicroStation 
Window) staat altijd zinnige informatie. In de Message 
Center staat informatie over de keuze die je gemaakt 
hebt: bijvoorbeeld ‘Select Element By Type - Arc & 
Ellipse Elements Selected’. Meer naar rechts, in de 
Statusbar, staat weergegeven hoeveel elementen gese-
lecteerd zijn.

iNvert seleCtiON
Als aardigheidje is in het Context Menu ook nog de 
optie Invert Selection te vinden. Deze optie zorgt er-
voor dat alle op dat moment geselecteerde elementen 
worden gedeselecteerd en dat de niet geselecteerde 
elementen juist wel geselecteerd worden. Stel je voor 
dat je alle elementen wilt kiezen, die niet Color 0 of 1 
zijn. Je selecteert dan eerst een element met kleur 0 en 
een element met kleur 1 en kiest voor Select Elements 
By...>Color in het Context Menu. Alle ‘foute’ elementen 
worden geselecteerd. Vervolgens druk je weer op de 
rechtermuisknop en kiest voor Invert Selection. 

sNel alle refereNCes aaN Of uit
Iedere knop in MicroStation roept een Key-in aan. Soms kan het 
handig zijn om een Key-in toe te kennen aan een functietoets, 
bijvoorbeeld om de weergave van alle References aan of uit te 
zetten. De Key-in ‘reference display toggle all’ zorgt ervoor dat 
alle References van weergave veranderd worden. Stel dat je dit 
aan functietoets F10 wilt koppelen, dan moet je het volgende 
doen. Kies de menu-optie Workspace>Function Keys, selecteer de 
gewenste functietoets (eventueel gecombineerd met Ctrl, Alt en 
Shift) en type bij Action de gewenste Key-in.

sNel wisseleN tusseN display styles
Als ik in een 3D-omgeving werk, wil ik vaak wisselen tussen Display 
Styles. Soms vind ik een Wireframe handig, of noodzakelijk, en een 
andere keer kies ik liever voor Illustration. Met de Key-in ‘change 
view custom illustration all’ verander je naar de Display Style 
Illustration. ‘All’ betekent dat dit voor alle Views geldt. Anders zou 
je eerst nog in een View moeten klikken. ‘Change view custom 
wireframe’ verandert de Display Style weer naar Wireframe. Even 
koppelen aan een functietoets en je kan snel wisselen.

Tekst: Richard Zethof, cad2reality
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Vernieuwde PowerCivil for Benelux
Tekst: Richard Zethof, cad2reality
Illustraties/foto’s: Bentley Systems

•  Krachtige, intelligente en intuïtieve 
civil information modeling voor de 
verwerking van landmeetkun-
dige inwinningen, schaalbaar terrein 
modelleren, weg- en landschapsont-
werp en ontwerp van rioleringen.

•  Volledige functionaliteit van Bent-
ley Map, een GIS-oplossing voor 
het exact creëren, onderhouden en 
analyseren van ruimtelijke informatie.

•  De mogelijkheid om naadloos samen 
te werken met zowel Bentley Naviga-
tor voor een iteratief controleproces als 
ProjectWise, voor de samenwerking 
van teams en het beheer van data.

•  Alle mogelijkheden van MicroStation, 
de standaard bij vele wegbeheerders, 
voor tekenen en produceren van 
documenten, zonder de noodzaak van 
een aparte MicroStation-licentie.

De kracht van PowerCivil for Benelux 
is verder uitgebreid met Civil Ac-
cuDraw, de civiel-specifieke versie van 
MicroStation AccuDraw. Een snel, 
nauwkeurig en intuïtief tekenhulpmid-
del dat anticipeert op de gebruiker 
en het aantal muisklikken drastisch 
vermindert. Omdat werkwijzen per 
project kunnen verschillen is PowerCi-
vil for Benelux volledig configureerbaar 
en bevat ook ingebouwde functio-
naliteit voor projectmanagement.

Jan Blaauboer, Industry Sales Director 
TLI bij Bentley Systems, zegt: “Power-
Civil for Benelux geeft ons ongekende 
technologie voor civieltechnische 
toepassingen, waarbij projectteams 
beter gebruik maken van informatie en 
op kostenefficiënte manier gegevens 
kunnen hergebruiken gedurende het 
hele project. Door de samenwerkings-
mogelijkheden, die ProjectWise biedt, 
kunnen multidisciplinaire projectteams 
eenvoudig CAD-gegevens, ruimtelijke 
informatie, overige projectdata en zelfs 
Microsoft Office documenten beheren, 
vinden, delen en visualiseren. Zelfs 
snelle toegang tot zeer grote bestanden 
is geen probleem en wijzigingen kun-
nen effectief en efficiënt doorgevoerd 
worden, zodat geen tijd verspild wordt 
en de kwaliteit van het project toe-

neemt. Daarbij is PowerCivil ook nog 
eens zeer scherp geprijsd. Ik ben ook 
heel blij met het feit dat onze business 
partner Para_Graph gelijktijdig een 
versie van haar NLCS-ontwerppakket 
Organize heeft geïntroduceerd, dat 
speciaal is ontwikkeld voor gebruik 
met PowerCivil for Benelux.”

De complete applicatie voor civiele 
techniek, transport en terreinontwerp 
biedt niet alleen de mogelijkheden 
van Bentley Map, maar ook vol-
ledige ondersteuning van DGN en 
DWG voor de stroomlijning van 
ontwerp, engineering, bouw en beheer 
met maximaal hergebruik van data. 
Import- en exportmogelijkheden zijn 
ruimschoots aanwezig, zoals XML-
bestanden, Trimble, TOPCON en 
Leica. Uiteindelijk zijn gebruikers in 
staat om Bentley i-models (containers 
voor uitwisseling van open infrastruc-
tuurgegevens) te creëren. Hiermee 
kunnen eenvoudig opmerkingen van 
reviewers gevonden, gecommuniceerd 
en verwerkt worden in een geïnte-
greerde workflow wat helpt bij een 
tijdige levering, binnen budget.  

Van PowerCivil is bekend dat dit een zeer 

krachtige applicatie met innovatieve gereed-

schappen is voor civieltechnische ingenieurs, 

ontwerpers en anderen.Het wordt gebruikt 

voor het ontwerp van (snel)wegen, bruggen, 

publieke werken en landschapsontwikkeling. 

Met een compleet pakket aan tekengereed-

schappen en krachtige GIS tools biedt PowerCivil 

for Benelux de mogelijkheid 3D te modelleren 

met een innovatieve benadering voor het ont-

werpen van civieltechnische oplossingen.
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Tekst en informatie is onafhankelijk 

geworden van perkament, papier 

en boek. Muziek is niet langer 

onlosmakelijk verbonden met 

een drager, zoals tape, LP of CD. 

En ook kaarten zijn leesbaar en 

generiek bruikbaar geworden, los 

van een fysieke drager. Als gevolg 

hiervan is informatie nu breed toe-

pasbaar en te combineren met an-

dere vormen van informatie. Nieu-

we toepassingen zijn ontstaan, 

die voorheen onmogelijk waren. 

De snelle opkomst en brede inzet-
baarheid van ICT heeft dit proces 
versterkt. Ook in het GEO-werkveld 
werd begonnen met automatisering; het 
vervangen van menselijke arbeid door 
computers en computerprogramma’s. 
De data en de nieuwe gegevens, die 
werden gecreëerd, beheerd en uitge-
wisseld, bleven direct verbonden met 
de computerprogramma’s. Data en 
applicatie (en vaak leverancier) waren 
weer onlosmakelijk verbonden. En 
alleen met ‘applicatiekoppelingen’ kan 
de informatie onafhankelijk worden 
van de applicatie. Dergelijke Legacy-
systemen, hoewel verouderd, zijn echter 
nog steeds in gebruik. En dat terwijl 
er open data- en applicatiestandaarden 
zijn. Sterker nog; die worden door 
INSPIRE, NORA, GEMMA, KING, 
PDOK, etc. voorgeschreven om aan 
te voldoen. Het Raamwerk van geo-
standaarden omvat standaarden voor 
metadata, services en informatiemodel-
len, sluit aan op de Europese infrastruc-
tuur en integreert het geo-domein met 
de elektronische overheid. Een aantal 
van de geo-standaarden staat zelfs op 
de ‘Pas toe of Leg uit’ lijst met open 
standaarden van het College Standaar-
disatie, waaronder IMGeo en dus de 
Basisregistratie Grootschalige Topo-
grafie; de BGT. Overheidsorganisaties 
zijn, te zijner tijd, wettelijk verplicht 
deze basistopografie te gebruiken en 
moeten wijzigingen en fouten melden. 
De BGT is daarbij ook bedoeld voor 
de geo-referentie van de ruimtelijke 
aspecten van andere objecten (d.w.z. 
als referentieobjecten en/of als onder-
grondkaart). En daar zit ‘m nu dus de 
uitdaging. Want hoe kan de overheid nu 
aan het adagium van open data voldoen, 
terwijl de gevestigde orde met hun 

Legacy-systemen doorbouwen op het 
oude model? Systeem-, architectuur-, 
applicatie- (en daarmee leveranciers-) 
afhankelijkheid is volop aanwezig . ‘Wij 
van WC-eend adviseren WC-eend’, 
zoals in de reclame hiermee de draak 
wordt gestoken. En dat terwijl de over-
heid nu juist de meerwaarde van RSGB, 
IMGeo (en dus de BGT) moet gaan 
vinden in het toepassen van die open 
data en het kunnen doorgroeien naar 
externe voorzieningen en 3D-toepas-
singen, zonder daarbij direct afhankelijk 
te zijn van ‘applicatiekoppelingen’ en 
extra leverancier gebonden applicaties. 

Dus bronhouder, denk aan de toekomst, 
bepaal niet alleen de wettelijke doelstel-
ling, maar definieer ook hoe de organi-
satie straks haar voordeel uit IMGeo en 
de BGT wil gaan behalen. Inventariseer 
de huidige kwaliteit van de data, hun 
applicatieafhankelijkheden en processen. 
Benut dan de transitie naar RSGB, IM-
Geo en de BGT om data en applicatie 
te scheiden! Het levert niet alleen een 
waardevolle basisregistratie, maar ook 
zoveel efficiency en meerwaarde op... 

Benut de BGT om data en applicatie te scheiden!
Tekst: Matty Lakerveld, Crotec

Tekst: Richard Zethof, cad2reality
Illustraties/foto’s: Bentley Systems
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Essent Local Energy Solutions tevreden over Bentley sisNET

Up and running in zes maanden

ELES is onderdeel van RWE AG, één 
van Europa’s leidende energiebedrijven. 
Met 300 werknemers en meer dan 
80.000 klanten, is het bedrijf hoofd-
aanbieder in grote steden in Noord-
Brabant. ELES exploiteert ook kleinere 
netwerken in Nederland, die verbonden 
zijn met biogas- en biomassacentrales. 
Het bedrijf ontwikkelt ook het gebruik 
van restwarmte van andere bronnen, 
zoals afvalverbrandingsinstallaties.
ELES kon tot 30 juni 2009 gebruik 
blijven maken van het bestaande 
GE-Smallworld GIS-systeem van 
Enexis (Essent’s voormalige netwerk-
bedrijf ), voordat haar eigen systeem 
geïmplementeerd werd en alle infra-
structuurgegevens uit Enexis GIS 
verwijderd moesten zijn. ELES had 
twee opties: één op één overnemen 
van het high-end en zwaar aangepaste 
GIS-systeem of opnieuw starten met 
een meer kosteneffectief alternatief. 
Omdat het GIS-systeem van Enexis 
te duur was voor het aantal gebruikers, 
werden alternatieven onderzocht.

Een stevige belofte

Naast het vinden van een oplossing 
met een lagere investering en opera-
tionele kosten, moest Essent alles op 
tijd afronden zonder verlies van data. 
Live data moest toegankelijk zijn 
voor mobiele werkers en het systeem 
moest voldoen aan de eisen van de 
WION (Wet Informatie-uitwisseling 
Ondergrondse Netten). Deze wet 
verplicht aannemers om een graafmel-
ding te doen bij het Kadaster om uit 
te vinden welke netbeheerders belang 
hebben op een bepaalde locatie.
De resultaten van een gedetailleerde 
evaluatie van aanbiedingen van vier 
potentiële leveranciers, gebaseerd op 
de Total Cost of Ownership over vijf 
jaar, zijn voorgelegd aan het manage-
mentteam voor het nemen van een 
beslissing. Dit leidde tot het Bentley 
sisNET multi-utility en multi-site 
GIS-gebaseerde asset management 
systeem, met de overtuiging dat 
hiermee de overgangsdeadline ge-
haald kon worden. Een andere reden 
waarom ELES voor de technologie van 

Nieuwe regelgeving maakt nieuw GIS noodzakelijk voor energiebedrijf

Door een aanpassing van de Nederlandse wet-

geving zijn energiebedrijven verplicht om hun 

netwerken, productie en verkoopactiviteiten te 

ontkoppelen. Om aan deze eis te voldoen moest 

Essent Local Energy Solutions (ELES), leverancier 

van duurzame stadsverwarmingoplossingen die 

gebruik maakt van restwarmte van koelwater van 

elektriciteitscentrales, een nieuw GIS selecteren 

en implementeren voor het ontwerp, beheer en 

de exploitatie van haar groeiende stadsverwar-

mingnetwerk. Bovendien moest dit in zes maan-

den gerealiseerd worden. Dit doel heeft ELES 

bereikt met de implementatie van Bentley sisNET 

voor de documentatie van haar stadsverwar-

mingnetwerk en ondersteuning van het exploi-

tatiegedeelte van de infrastructuurlevenscyclus.
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Essent Local Energy Solutions tevreden over Bentley sisNET
Tekst, foto’s en visualisaties: Bentley 
Vertaling: Ilse Zethof, TriCentric

Bentley heeft gekozen, is omdat het 
samenwerkt met de Bentley sisHYD 
software voor netwerkanalyse en 
thermische en hydraulische bereke-
ningen, die ELES in gebruik heeft.

Een veelomvattend GIS-systeem

Het nieuwe systeem maakt het mo-
gelijk dat gegevens zonder vertraging 
beschikbaar zijn voor Bentley sisHYD 
ten behoeve van hydraulische en ther-
mische berekeningen, die noodzakelijk 
zijn om leidingen te optimaliseren in 
stadsverwarmingnetwerken. Bentley 
sisHYD ondersteunt ook het model-
leren van een uitgebreide reeks aan 
“what-if ” condities, zoals klep open/
klep dicht. Met MicroStation als hart 
van het systeem biedt Bentley sisNET 
een configureerbaar datamodel voor 
stadsverwarming, bedrijfsvoorwaarden 
en menustructuur. Bentley sisIMS, 
gebaseerd op Geo Web Publisher, 
wordt gebruikt om de netwerk-infra-
structuurdata beschikbaar te maken 
in een web (viewing)-omgeving in 
Adobe SVG formaat. De applicatie 
voorziet zowel in volledig toegankelijke 
kaart- en attribuutgegevens en heeft 
redlining mogelijkheden, waardoor de 
mensen ‘in het veld’ met internettoe-
gang de database kunnen gebruiken en 

werklocaties, netwerkonderbrekingen 
en nog meer kunnen lokaliseren.

Opgeleverd zoals beloofd

De implementatie is gestart in januari 
2009 en volgens planning afgerond. 
Koen Albers, team manager van de 
afdeling Project Support (waaronder 
ook de tekenkamer valt), heeft het 
budget en het proces beheerd. Een 
projectleider van Bentley, een vertegen-
woordiger van de ELES IT-afdeling 
en twee ‘power-users’ hebben gehol-
pen bij het definiëren van de eisen en 
hebben het systeem geaccepteerd.
Het project- en datamigratieplan 
vereisten grote inspanningen van het 
team. Het omvatte de uitvoering en 
het beschikbaar stellen van middelen, 
analyse van het Smallworld-datamodel 
en migratie hiervan, installatie en confi-
guratie van de software en de uitrol voor 
productie. Een nauwkeurige handlei-
ding voor de datamigratie was gecreëerd 
om de eventuele risico’s van het datami-
gratiemodel te kunnen beheren. De vol-
gende stap voor ELES is het realiseren 
van een nauwe koppeling tussen Bentley 
sisNET en Ultimo, omdat de ‘Directie 
Toezicht Energie’ doorgaat met het 
monitoren van de asset management 
strategieën van energiebedrijven.

Bentley ondersteuning  

sleutel tot succes

De projectmanager van Bentley was 
intensief betrokken bij de specificaties, 
de planning van de implementatie en 
de exacte configuratie voor ELES. Het 
flexibele systeem voorziet ELES van 
zowel een configureerbaar datamodel 
als extra functionaliteit. Omdat de 
data wordt opgeslagen in een Oracle 
Spatial database, wat een open systeem 
is, wordt ELES niet gedwongen voor 
een systeem door databasetechnologie.
Een andere factor, die het project 
geholpen heeft om de deadline te 
halen, is de standaard aanwezige 
functionaliteit en datamodel voor 
stadsverwarming in Bentley sisNET, 
waardoor geen maatwerk nodig was. 
Bovendien werken Bentley sisHYD 
en Bentley sisIMS direct met Bentley 
sisNET bestanden, waardoor volle-
dige integratie en compatibiliteit zijn 
gegarandeerd. Hierdoor is data-invoer 
en vertaaltijd voorkomen en het risico 
op kostbare fouten, die niet direct 
aan het licht komen, sterk geredu-
ceerd. Hier kwam nog bij dat ELES 
al gebruik maakte van MicroStation 
voor kleine engineering projecten, 
waardoor gebruikers al bekend 
waren met de “look and feel” van  

Nieuwe regelgeving maakt nieuw GIS noodzakelijk voor energiebedrijf
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de applicatie. Dit betekende dat meer tijd kon worden besteed aan 
specifieke training van Bentley sisNET en Bentley sisIMS.

Melden voor je graaft

Zoals bekend moeten aannemers (‘grondroerders’) een graafmelding doen 
bij het Kadaster om te kunnen bepalen welke netbeheerders ondergrondse 
infrastructuur hebben op de graaflocatie. Vervolgens moeten netbeheer-
ders met informatie komen over de ligging hun netwerk. Voorheen was dit 
een tijdrovend, handmatig proces. Dit is echter vervangen door een auto-
matisch systeem, waarmee zeer veel kosten bespaard worden. Informatie 
wordt automatisch verkregen door gebruik van internet robots. Bentley 
heeft hiervoor samengewerkt met ELES partner Geodan om er zeker van 
te zijn dat Bentley sisNET informatie levert, die voldoet aan de wet.

Binnen budget en op tijd

Albers merkt op: “Ik ben gelukkig met dit systeem. Door de inspanning, die 
we gestoken hebben in het duidelijk krijgen van de projectdoelen en het uit 
te voeren werk heeft Bentley sisNET aan alle eisen en wensen voldaan. We 
wilden een kostenefficiënte applicatie zonder de noodzaak van maatwerk en 
we wilden alle functionaliteit van ons vorige systeem met de nodige verbete-
ringen. Het totale Bentley sisNET systeem, inclusief de complete datamigra-
tie, is op tijd en binnen budget geïmplementeerd. Een ander voordeel is dat de 
Bentley gemeenschap in Nederland groeiende is met nog twee implementaties 
van Bentley sisNET in de elektriciteitstransmissie en distributie-industrie.” 

“Nu hebben we een kostenefficiënte applicatie 
zonder extra maatwerk en met de nodige 
verbeteringen ten opzichte van ons vorige systeem”
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Tekst: Robert Janssen, Gemeente Almere en 
bestuurslid TMC Focusgroep Geo

Hoe maak je een Geogerefereerde PDF?

In MicroStation is het al een tijd mogelijk bij het aanmaken 
van een PDF de lagen mee te sturen. In de huidige versie van 
MicroStation kan een PDF worden aangemaakt, waarbij de 
ligging en grootte direct kan worden meegegeven. Met deze 
functionaliteit behoren de nabewerkingen om de PDF netjes 
op positie te krijgen – lees Move; Scale; Rotate of Warp - tot 
het verleden. Een geogerefereerde PDF kan worden aan-
gemaakt doordat het in MicroStation nu mogelijk is om een 
coördinaatsysteem aan een tekening te koppelen, zoals dat 
met Bentley Map al een geruime tijd kan.

Stap 1: een bestaande designfile een coördinaatsysteem kop-
pelen. Dit kan door via Menu ‘Tools’ te kiezen voor de optie 
‘Geographic’ en dan ‘Select Geographic Coordinate System’. 
Activeer de tweede knop ‘From Library’ en kies uit de boom-
structuur het coördinaatsysteem dat in Nederland gebruikt 
wordt RD (zie onderstaande afbeelding) en bevestig met OK.

Het coördinatiesysteem is nu aan de tekening gekoppeld en 
de eigenschappen zijn ook zichtbaar in het venster Geograp-
hic Coordinate System. 

Het gekozen coördinaatsysteem kan ook direct onder de 
favorieten worden gezet door in de boomstructuur met de 
muisaanwijzer op het betreffende coördinaatsysteem te gaan 
staan en via de rechtermuisknop te kiezen voor ‘Add To 
Favorites’.

Stap 2: het instellen van de printer-driver eigenschappen. 
Activeer de knop ‘Print’ en kies via het menu ‘File’ en ‘Select 
Bentley Driver’ voor pdf.pltcfg. Kies daarna via het menu ‘File’ 
voor de optie ‘Edit Printer Driver Configuration’, activeer het 
tabblad ‘Base Properties’ en klap het onderdeel ‘Driver Pro-
perties’ open. Zet de optie ‘Enable Georeferencing’ op ON en 
bewaar de instelling via File>Save As.. Dit om het origineel te 
hernoemen.

Stap 3: het uitproberen van het Geogerefereerde bestand. We 
koppelen de aangemaakte PDF aan via de Raster Manager; 
menu File >Attach>Raster. Wat opvalt als ‘Raster Preview’ is 

ingeschakeld is dat onder de afbeel-
ding ‘Origin’ direct het coördinaten-
paar (linker onderhoek) zichtbaar is. 
Zorg wel dat het vinkje voor Place 
Interactively uitgeschakeld is.

Indien een bronbestand met een co-
ordinaatsysteem is aangekoppeld als 
reference file, kan hiermee ook direct 
geogerefereerde PDF’s gemaakt wor-
den. Om na te gaan of het referentie-

bestand een coördinaatsysteem bevat, kan de kolom ‘GeoCS’ 
worden aangezet en wordt deze getoond. 
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SPONSOR AAN HET WOORD

 3D Printen

Een plaatje zegt meer van duizend 
woorden, een tastbaar model meer dan 
duizend plaatjes! Waar men het jaren 
geleden nog met 2D-werktekeningen 
moest doen, zijn 3D-modellen en 
visualisaties inmiddels meer dan 
normaal. Een tastbaar model dat in 
de hand gehouden kan worden of op 
tafel van alle kant kan worden bekeken, 
biedt veel meerwaarde. Het geeft meer 
inzicht in verhoudingen, ruimte, details 
en bovendien kan het een waardevolle 
ondersteuning zijn bij de ontwikkeling 
en verkoop. Het maken van traditio-
nele maquettes kost vaak veel tijd en 
geld. 3D printen gaat snel, de meest 
waanzinnige vormen zijn mogelijk 
en het kan allemaal in full color. 

De toepassingen zijn ontelbaar. Denk 
maar aan maquettes van huizen en 
gebouwen, plants voor olie- en gasin-
dustrie, schepen, 3D GIS-modellen, 
awards, unieke relatiegeschenken, 
snelle prototypes bij productontwikke-
ling, kunst etc.. Het is moeilijk om te 
geloven, maar bij cad2reality komt dat 
allemaal direct en compleet in kleur uit 
een 3D-printer. Iedereen is dan ook van 
harte uitgenodigd om eens een kijkje 
te komen nemen naar de vele voorbeel-
den en de 3D-printer aan het werk te 
zien, maar ook op de website zijn per 
toepassing vele voorbeelden te zien.

Trefwoorden voor 3D printen zijn:
•  Uniek
•  Kleine oplages
•  Full color
•  Snel
•  Prijstechnisch interessant

3D modelleren 

Hoewel cad2reality graag van ieder idee 
iets tastbaars wil maken, is dat soms 
(nog) niet gewenst. Daarom kunt u ook 
voor het genereren van een 3D CAD-
model bij hen terecht. Leg uw idee uit, 
of lever een schets of 2D-tekeningen 
aan en er wordt een 3D-model van 
gemaakt. Dit kan opgeleverd worden 
in bijna ieder gewenst bestandsfor-
maat, zoals: AutoCAD, MicroStation, 
ARC+, SketchUp, Parasolid (bijv. *.x_t), 
ACIS (*.SAT), 3D-PDF en meer.

3D scannen

Deze technologie is erg in opmars. 3D 
scannen kan voor veel verschillende 
doelen ingezet worden. Of het nu 
gaat om het scannen van een gebouw, 
(delen van) mensen, dieren en grote of 
kleine objecten, met of zonder kleur, 
cad2reality heeft er een oplossing voor. 
Uiteraard kan van deze modellen een 
3D-print gemaakt worden zodat een 
identieke replica ontstaat, maar ook vele 
andere toepassingen zijn bedenkbaar, 
zoals de verwerking in een CAD-
model of gebruik in animaties etc.

cad2reality: gedreven en passie voor 3D
Experts in 3D printen, visualisaties en MicroStation consultancy en trainingen 

3D-print van onshore plant

Boven v.l.n.r.: 3D-prints van maquette van bestaande en 
nieuwe bebouwing, GIS-model, bouwputmodel van nieuwe 

markthal in Rotterdam en relatiegeschenk voor TNT.

Meer dan twintig jaar kennis van 

3D-modelleren, visualisaties, advisering, 

trainingen en consultancy is de basis 

van een compleet expertisecentrum op 

3D-gebied onder de rook van Amsterdam. 

De unieke bundeling van technische en 

commerciële kennis en passie voor alles wat 

met 3D te maken heeft, maakt cad2reality 

tot een betrouwbare en ervaren partner. 

3D printen, 3D scannen, 3D modelleren, 

visualisaties, MicroStation consultancy 

en trainingen. Het is allemaal mogelijk 

bij Jan Oliemans en Richard Zethof, die, 

samen met mensen ‘in het veld’ en 

partners, graag voor u klaar staan.
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cad2reality: gedreven en passie voor 3D
Experts in 3D printen, visualisaties en MicroStation consultancy en trainingen 

Visualisaties

Het maken van visualisaties is ook een 
belangrijke activiteit van cad2reality. Lijn-
perspectieven, fotorealistische visualisaties, 
fotomontages, panoramaviews, ingekleurde 
plattegronden, animaties en presentatie-
boekjes. Er is veel mogelijk. Wederom geldt 
dat u terecht kunt vanaf het idee of schets, 
maar ook voor visualiseren op basis van 

aangeleverde (digitale) tekeningen. Zeer interessant is de combinatie 
van visualisaties en 3D-printen van maquettes. De 3D-modellen die 
cad2reality genereert voor visualisaties zijn namelijk direct geschikt 
voor 3D-printen. Dit kan aanzienlijke kostenbesparingen opleveren.

MicroStation

Richard Zethof is bekend als dé onafhankelijke consultant en trainer op 
gebied van Bentley producten en schrijver van vele artikelen over Bentley 
gerelateerde oplossingen en tips en trucs. Trainingen worden vaak bij 
de klant gegeven, wat veel voordelen oplevert. Maar ook organiseert 
cad2reality klassikale cursussen in Aalsmeer en in Wommelgem (België). 
Trainingen zijn altijd op maat en er wordt goed naar de wensen van de 
klant geluisterd. Het aanbod varieert van een basiscursus MicroStation, 
gevorderd, 3D basis en gevorderd tot systeem- en applicatiebeheer. 

Onlangs is cad2reality een strategische samenwerking met 4D-select 
aangegaan. 4D-select is gerenommeerd Bentley Institute Centre met 
een kantoor vlakbij Antwerpen en de Benelux als werkgebied. Naast 
trainingen kunt u bij cad2reality ook terecht voor werkplekbegelei-
ding, advisering over hardware en Bentley software, implementatie (of 
advies hierover) en support (zowel on-site als remote) op het gebied 
van MicroStation. Als extra service heeft cad2reality een rubriek op de 
website met tips & trucs op het gebied van MicroStation. Kennis wordt 
graag gedeeld! 

de meNseN aChter Cad2reality
Ing. Jan Oliemans (rechts op de foto), bouwkundig 
ingenieur, heeft lange ervaring op zowel bouwkun-
dig- als interieurgebied. In combinatie met kennis 
van 3D-modelleren en visualiseren, heeft dit ge-
resulteerd in zeer veel driedimensionale presen-
taties, fotorealistische visualisaties en animaties. 
Vanaf idee of schets kan door Jan van ieder gewenst 
bouwkundig object of interieur een visualisatie of 
een ‘printbaar’ model gegenereerd worden.

Ir. Richard Zethof (links op de foto), civieltechnisch in-
genieur, heeft een rijk verleden op het gebied van ver-
koop, ondersteuning en training van CAD-systemen en 
randapparatuur en is CAD-specialist bij uitstek. Of het 
nu gaat om consultancy, ondersteuning, implementa-
ties, advisering en trainingen op het gebied van Micro-
Station, Richard heeft hiervoor gedegen kennis in huis.

cad2reality
Mijnsherenweg 33
1433 AP Kudelstaart
Tel: 0297-368 516      
info@cad2reality.nl

www.cad2reality.nl

3D-print luxe appartementen 3D-print 
gezichtsbedrog
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COlOfON

MicroVisie Magazine, onafhankelijk 
vakblad voor gebruikers van Bentley 
software, richt zich op management, 
beleidsvorming en toepassing van o.a. 
CAD, GIS en document management 
software. MicroVisie Magazine is een 
uitgave van TMC Nederland.

tmC NederlaNd
Postbus 38, 5680 AA Best
Telefoon: + 31 499 330894
Fax:  + 31 499 330626
Email:  info@tmc-nederland.nl
Website:  www.tmc-nederland.nl

redaCtie
Ilse Zethof
Email: microvisie@tmc-nederland.nl

met medewerkiNg vaN:
Jan Blaauboer, Douwe Blanksma,  
Freek Boersma, Robert Janssen,  
Gijs Koedam,  Matty Lakerveld,  
Arjen de Leeuw, Fabienne Pinot,  
Christiaan Post, Stem uit het Veld,  
Suzanne Scholte, Ton de Vries,  
Esther de Wijs, Richard Zethof

abONNemeNteN
Voor informatie over abonnementen:
Mary van der Meer: +31 499 330894
Verschijnt 3x per jaar.
Nederland: 50 euro per jaar.
Abonnement is inclusief persoonlijk lidmaat-
schap TMC Nederland voor 1 jaar (persoon-
lijk lidmaatschap is niet overdraagbaar op 
een collega). Een andere vorm van (bedrijfs-) 
lidmaatschap is uiteraard mogelijk. Informatie 
op te vragen bij secretariaat TMC. Abon-
nement/lidmaatschap kan op elk gewenst 
tijdstip ingaan, maar wordt gefactureerd per 
kalenderjaar (januari t/m december) of een 
deel daarvan. Alle abonnementen/lidmaat-
schappen worden automatisch verlengd, 
tenzij de abonnee voor het einde van het 
jaar schriftelijk opzegt. MicroVisie Maga-
zine wordt gratis verspreid onder leden van 
TMC Nederland. 

vOrmgeviNg

drukkerij
Ovimex, Deventer

COpyrights
Het auteursrecht op deze uitgave en op de daarin 
verschenen artikelen wordt door de uitgever voorbe-
houden. Het verlenen van toestemming tot publicatie 
in deze uitgave houdt in dat de auteur de uitgever, 
met uitsluiting van ieder ander, onherroepelijk mach-
tigt de bij of krachtens de Auteurswet door derden 
verschuldigde vergoedingen voor kopiëren te innen 
en dat de auteur alle overige rechten overdraagt 
aan de uitgever. Niets uit deze uitgave mag worden 
overgenomen, vermenigvuldigd of gekopieerd zonder 
uitdrukkelijke toestemming van de uitgever. De 
uitgever stelt zich niet aansprakelijk voor eventuele 
onjuistheden welke in de uitgave mochten voorkomen.

Ja, u leest het goed: de ‘Stem uit het Veld’ is weer terug in  
MicroVisie Magazine. In 2002 werden de laatste MicroVisies 
uitgegeven, toen nog door Bentley, en daar stond steeds deze 
rubriek in. Weet u het nog? Soms kritisch, soms optimistisch, maar 
altijd met een scherpe blik op de Nederlandse Bentley-wereld. Het 
heeft toen heel wat los gemaakt, waar zelfs tijdens een keynote-
presentatie op een Bentley evenement naar verwezen werd. Tot op 
de dag van vandaag is, met uitzondering van een paar mensen na, 
nog niet bekend wie de man of vrouw achter die spraakmakende 
column was. Maar hij of zij kan nog handig zijn voor volgende 
MicroVisie-uitgaven, dus het wordt niet bekend gemaakt. 

De redactie van nu wil de ‘Stem uit het Veld-rubriek’ nieuw leven in blazen. 

Maar deze keer kan iedereen daaraan bijdragen. Dus hierbij een oproep aan 

alle TMC-leden en relaties om hieraan mee te werken. Alles mag geschre-

ven worden. Als het maar interessant is voor de gebruikers van Bentley-

software. En het moet wel fatsoenlijk en niet commercieel zijn. Het mag 

anoniem of met naamsvermelding. De redactie heeft de eindredactie. 

Maar nu genoeg reclame gemaakt voor de rubriek. De redactie heeft mij niet 

voor niets gevraagd om de eerste ‘Stem uit het Veld’ te zijn. Ik vind het leuk 

om anoniem te blijven. Weer eens wat anders dan met al die sociale media 

tegenwoordig. Sommigen zijn hier zo fanatiek in dat je er gewoon akelig van 

wordt. Enfin, iedereen mag hier zijn eigen invulling aan geven. Het heeft zeker 

ook voordelen. Dat hebben we vorig jaar kunnen horen tijdens de openings-

presentaties van het TMC Forum in Hilversum. Daar was overigens ook zeer 

veel sociale media, maar dan lekker ouderwets face to face. Gezellig met 

elkaar van gedachten wisselen en ervaringen delen. Je pikt toch altijd wat 

op tijdens zo’n evenement en gaat naar huis met nieuwe kennis. Tenminste, 

dat geldt voor mij. Om bij te blijven bezoek ik regelmatig bijeenkomsten 

van TMC Nederland. E-seminars van Bentley zijn niet aan mij besteed, al is 

het alleen maar omdat het in het Engels is. TMC heeft dat zeer goed be-

grepen. Gelukkig kan er ook weer in onze vertrouwde 

taal gelezen worden. Ik ben erg blij dat MicroVisie er 

weer is. En dan nog wel als tijdschrift, wat wil je 

nog meer? Ik snap dat er overal bezuinigd moet 

worden en dat steeds meer digitaal wordt (neem 

ook alle uitingen van Bentley), maar toch vind 

ik het prettig om met een boekje op de 

bank of in de trein te zitten. Gewoon 

lekker doorbladeren. TMC Nederland, ik 

hoop dat jullie hier nog lang mee door 

zullen gaan als service voor de leden! En 

met jullie andere activiteiten trouwens ook. Ik besef 

dat er door sommigen van jullie veel tijd (van de 

baas en privé) wordt gestoken in deze gebruikers-

groep, maar Nederland kan niet meer zonder jullie. 

Hoop dat Bentley zich daar ook bewust van is…. 

               stemuithetveld@tmc-nederland.nl 

Stem uit het veld
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THE 3D GIS FOR INFRASTRUCTURE –  
EXPERIENCE THE POWER OF BENTLEY MAP
GIS is going 3D and the benefits are enormous. With Bentley Map, you’ll gain the additional ad-
vantage of a GIS that’s both intrinsically 3D and optimized for the rigorous demands of sustaining 
infrastructure. Bentley Map supports 3D objects in Oracle Spatial natively, has smart 3D object 
editing tools, and executes advanced 3D spatial analyses as well as standard 2D routines.

Bentley Map is the choice of infrastructure professionals around the globe. It has all the power  
of MicroStation to make workflows efficient, and includes innovative and comprehensive map 
finishing functions as well as advanced parcel management functionality.

Featuring an extended API, the latest version of Bentley Map is optimized for developers and en-
terprise deployments alike. It comes in three editions to meet a range of user needs – from light 
editing and review, to 2D and 3D spatial information creation and analysis, to advanced raster 
image management and long transactions using Oracle Spatial.

Find out why Bentley Map is advancing GIS for infrastructure at www.bentley.com/map.

© 2011 Bentley Systems, Incorporated. Bentley, the “B” Bentley logo, Bentley Map, and MicroStation are either registered or unregistered trademarks or service marks of Bentley Systems, Incorporated or one of 
its direct or indirect wholly owned subsidiaries. Other brands and product names are trademarks of their respective owners.

www.bentley.com/map

ADvANCING GIS FOR INFRASTRUCTURE

Bentley Map® PowerView 
Bentley Map® *
Bentley Map® Enterprise
*runs stand-alone or on MicroStation®

CHECk OUT THE NEW
BENTLEY MAP EDITIONS

Data courtesy City of Quebec
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NedBGT! Dé oplossing 
voor bronhouders die 
kiezen voor kwaliteit!
BGT  Als het gaat om de invoering van Basisregistratie Grootschalige Topografi e (BGT), kunt u niet 
vroeg genoeg beginnen met de voor bereidingen. Er komt nogal wat bij kijken om bestaande informatie 
te laten voldoen aan de eisen van de BGT. NedGraphics (h)erkent uw problematiek.

NedBGT  NedGraphics heeft NedBGT ontwikkeld om u te ondersteunen bij alle komende fases van de 
BGT. Zowel voor ondersteuning in de transitiefase en ook alvast voorbereid op de beheer en distributie-
fase van de BGT bent u bij NedGraphics aan het juiste adres.

Kwaliteit  Een investering in de juiste software leidt tot betere dienstverlening, betere samenwerking 
en kostenbesparing. Dat is het voordeel van kiezen voor kwaliteit. Maakt u tevens gebruik van onze 
adviesdiensten (projectleiding, quick scan, conformiteitstoets, plan van aanpak, masterclass) dan heeft 
u werkelijk alle zekerheid dat u een rendabele en duurzame investering doet. Bel of mail ons voor een 
nadere kennismaking!

Postbus 151, 4130 ED Vianen, (0347) 32 96 00
info@nedgraphics.nl, www.nedgraphics.nl
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